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Welcome to the Prosurv DMX™ Quick Start Guide! 
 

Thank you for purchasing Prosurv DMX.  We hope that this software provides you with the power and flexi-
bility to run most any lighting show.  Please call us, toll-free (in the US) at 888-647-9500 if you have any 
questions concerning this software.  Or, visit us on-line at www.prosurv.com/dmx. 
 
Installing Prosurv DMX 
Here’s a few important notes: 

• Prosurv DMX should install and run fine on most any modern Windows PC, including those with 
the following operating systems: 

• Windows ME 
• Windows XP 
• Windows Vista 

• Prosurv DMX is designed for screen resolutions of 1280x1024, but, you don’t have to have a 
screen that large!  If your PC or laptop only has 1024x728 or 1024x800 resolution, you can tailor 
the program by removing (turning off) some of the unused control boxes.  You can also move 
boxes around on the screen.  So Prosurv DMX will work on virtually on screen “size” or resolu-
tion...but, the bigger, the better! 

• Prosurv DMX uses the USB DMX box which is available on-line at www.usbdmx.com.  Please 
contact Ben Suffolk to order the box, or if you have any questions concerning the use of the USB 
DMX box. 

• The “Prosurv DMX Installation.exe” file that you downloaded will install 3 things: 
1. Prosurv DMX software 
2. Microsoft .NET 2.0 Framework 
3. The drivers for the USB DMX box.  Do NOT connect the box to your PC or laptop until 

the drivers have been installed. 
• The USB DMX box acts like a “virtual” communications port (serial port) on your PC, once the 

drivers are installed and you’ve connected the USB cable.  So, for Prosurv DMX to communicate 
with the box, you must select a comm port from the drop-down list in Prosurv DMX...but, we’ll get 
to that later. 

 
Enough with the Notes!  Let’s install the program! 

• Step 1:  Double-click the “Prosurv DMX Installation.exe” file that you downloaded from the inter-
net. 

• Step 2:  Once you accept the end user license agreement, the installation will begin.  If you don’t 
accept the end user license agreement, then you can not use the software. 

• Prosurv DMX is installed first, followed by the installation of Microsoft .NET 2.0.  Finally, 
the drivers for the USB DMX box are installed. 

• Step 3:  Once the drivers for the USB DMX box have 
been installed, you can connect your USB DMX box via 
a USB cable to your PC or laptop. 

• A virtual PORT for the USB DMX is created.  
This is the port that you will use when running 
Prosurv DMX.  Once the Box is connected to 
your PC, you can view the port by going to the 
Device Manager on your PC and looking at the 
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Ports.  You should see “USB Serial Port (COMx)” where x is the new com port number. 
 

• A shortcut to Prosurv DMX will appear on your Desktop. 
• Step 4:  Double-click the new Prosurv DMX shortcut (on your Desktop) to get started using 

Prosurv DMX! 
 
IMPORTANT NOTE: 
 
The first time you start the program, you will see the box shown 
to the left.  Don’t Panic!  Just hit OK.  Then, when the program 
closes, re-run the program by double-clicking the Prosurv DMX 
shortcut again.  You only need to do this once. 

 
 
 
Once you re-start Prosurv DMX, your user 
key is displayed.  You will need to call Pro-
surv LLC at 888-647-9500 (toll-free in the 
US), or e-mail us at dmx@prosurv.com with 
your user key.  We will then issue you an Ac-
cess Key that will unlock the program. 
 
We apologize for any inconvenience that this 
may cause, however, this method helps pro-
tect Prosurv LLC from software pirates 
(aargh!). 
 

When you receive the Access Key, type it in and click Continue. 
 
You will now be able to use Prosurv DMX. 
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1.  The Prosurv DMX screen 
Prosurv DMX is designed for screens that are capable of 
1280x1024 resolution.  But don’t worry, we know that a lot of 
laptops don’t have resolutions this high, so we made it possible 
for you to “hide” and “move” different boxes on the screen! 
 
Of course, if you need all the control boxes, then you can simply 
scroll up/down and left/right to get to other areas of the screen. 
 
The program starts out by showing you all of the control boxes.  
We recommend that the first thing you do is get comfortable 
with the screen by eliminating certain boxes and/or moving them 
around. 
 
The screen in a nutshell: 

• There are 5 control boxes.  Each one of the 5 performs the same task which is controlling one or 
more RGB or Standard PAR cans (LED or otherwise).  Each control box can create a sequence of 
colors that are applied to the fixtures that you’ve selected in the fixture list for that box.  Each box 
offers a lot of control, but we’ll save that for later. 

• There is 1 “Quick Set” box.  This box lets you choose one or two colors and then apply them to any 
fixture in the list instantly.  It overrides everything else that is going on.  This is a great way to be 
able to blackout all but one fixture, or instantly set all fixtures to a certain color. 

• Two Laser Controller boxes.  Each box is really designed to only control 1 laser.  Therefore, we 
give you two laser controller boxes.  Each one allows you to select a laser and then choose which 
laser pattern and color(s) to display. 

• Gobo/Moving Fixture box.  This box contains controls for gobos and moving fixtures.  If your gobo 
is also a moving fixture (with pan/tilt), then this box is for you.  All gobos and moving fixtures in 
your personal library can be controlled with this box. 

• 17 channel DCA (Direct Channel Access) faders.  You can instantly control up to 17 different 
channels using this single fader box.  But, of course, you may never need to use them! 

 
To make a box appear or disappear, simply check or uncheck the menu item 
for that box.  If you close Prosurv DMX, don’t worry, your box settings are 
remembered! 
 
To move a Box around, simply click and drag 
the box around.  Let go when you’ve reached 
the desired position (or your finger gets tired). 
 
 
 
 
 
 
 
 

 
 
 
 
 

Click and drag where it 
says ‘Control Box 3’ 
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2. Set the Comm Port 
Prosurv DMX needs to be able to communicate with the USB DMX box (which in turn tells your DMX fix-
tures what to do).  Naturally, the USB DMX box should be connected (via a USB cable) to your PC.  It is im-
portant that you know the comm port number associated with the box.  If you’re not sure what the number is, 
try this: 

1. Exit the Prosurv DMX program. 
2. Open the Device Manager on your PC.  In Windows XP, you can right-click My Computer, then 

select Properties.  Click on the Hardware Tab.  Now click on Device Manager. 
3. Look at the Ports (COM & LPT).  In the example shown here, the correct port is ‘USB Serial Port 

(COM8)’.  However, you may have other USB ports, so be careful to choose the correct one.  One 
good way to tell is to unplug the USB cable coming into the PC from the USB DMX box.  Then, 
you should notice which com port disappears.  Next, plug the USB DMX cable back into the PC.  
You should be able to notice the port that reappears. 

4. Start the Prosurv DMX program. 
 
To set the comm port that Prosurv DMX uses, look in 
the Menu under Tools and select Comm Port Settings. 
 
 
 
 
 
 
 

Select the correct comm port and click OK.  Don’t worry, 
you only have to do this once!  The port is opened automati-
cally by Prosurv DMX, and will be automatically closed 
when you close the program.  This is important so that the 
port doesn’t “jam up”.  If you ever see the words “Comm 
Port Closed” (which is rare) at the bottom of the Prosurv 
DMX screen, then you can “reset” the port by: 
 
 

1. Unplugging the USB cable from your PC that leads to your USB DMX box. 
2. Wait 5 seconds. 
3. Plugging the USB cable back in. 
4. Going to Tools-->Comm Port Settings, select your Comm port, and click OK. 

 
The bottom of your Prosurv DMX screen should always say “Comm Port Open”, unless you don’t have the 
USB DMX box hooked up to your PC or laptop. 
 
Note:  The port will open automatically when starting Prosurv DMX (if you’ve already chosen a valid port, as 
directed above). 
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3.  Create your own personal fixture list 
 
Prosurv DMX has a built-in Fixture Library.  It has 
started out small, but it is growing.  The idea is that you 
select your fixtures from the library and create your very 
own Personal Fixture List. 
 
A few notes about your Personal Fixture List: 

• The list is stored automatically in a folder called \Prosurv DMX Files\ which is located in the \My 
Documents\ folder of your PC.  The list is called “User Fixture List.txt”.  Yes, it is a text docu-
ment that you can open with Notepad, although you’ll probably never need to. 

• You can view and edit the fixtures in your personal list using the View/Edit Fixtures menu. 
• You create and add to the list by clicking on the Add Fixtures to Personal Fixture List menu (or just 

press F10). 
 
Let’s say for now that you have two fixtures that are 
already in the Prosurv DMX Library.  Remember--the 
Prosurv DMX Library is the MAIN library.  Your Per-
sonal Fixture List is just that--your list of fixtures that 
you own (or are using).  To begin making your Per-
sonal Fixture List, just click on “Add Fixtures to Per-
sonal Fixture List” under the Edit menu. 
 
 
 
 

You can scroll down to see more fixtures.  For this example, we’ll say we own a COLORpalette and a COL-
ORstrip by Chauvet.  So first, click on the COLORpalette row. 

 
A box appears, asking you for a unique name.  Be sure to give it a name 
that makes sense to you.  Do not use the same name for another fixture. 
 
 
 
 
Next, give the fixture the starting DMX address that you’d like to use.  
The next available DMX address is displayed automatically.  If you really 
want to get going quickly, just let Prosurv DMX calculate and assign each 
DMX starting address for you!  Then, simply set your fixtures to the ad-
dresses shown on the main screen.  Chances are, you’ll never need to 
change them again, ever! 

 
Your list has been created and the COLORpalette has been stored! 
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Click on the COLORstrip row.  Give it a unique name, such as ‘Strip 
Left’. 
 
 
 
 
Note the automatic starting address of Channel 28, since the COLORpal-
ette has 27 channels. 
 
 
 
 

 
 
 
 
 
Click OK. 

 
Now, close the Select Fixtures window.  All of the lists of each Con-
trol Box are filled in automatically. 
 
For this example, we go ahead and physically set the actual fix-
tures as follows: The Palette (COLORpalette) channel to 1; The 
COLORstrip channel to 28. 
 
 
 
 
 
 
 

If your fixture uses dip switches to assign channels, you can use 
the very handy DMX Address Dip Switches utility found under 
the Tools menu!  Simply enter your address, and the dip switch 
pattern is displayed! 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note that the Unique Names and 
Starting Channel are displayed for 

each fixture in your Personal Fixture 
Library. 
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4.  Using a Control Box! 
 
First, connect your fixtures together using DMX cables.  Be sure 
that your starting channel for each fixture is correct, as displayed in 
the list boxes.  Also be sure that your USB DMX box is connected 
to a fixture in the line and that the box is connected via a USB cable 
to your PC or laptop.  Then go ahead and “daisy chain” the other 
fixtures together using more DMX cables. 
 
Finally, check that the bottom of the Prosurv DMX screen says       
 
OK, now let’s get some lights going! 
 
Initially, there are 5 black boxes in each Control Box.  Just click on a box (above the ‘Use’ check box), to see 
the color selection window. 

 
 
 
 
 
 
 
 
 
 
Select a new color and click OK.  The new color is then displayed in the box. 
 
 

You can use up to 5 different colors for the selected fixtures. 
 
Be sure to select each fixture that you want to use.  In other words, check the box next to the fixture in the fix-
ture list, if you want this fixture to be controlled by this Control Box. 
 

• The Loop check box, if checked, will cause the selected fixtures to ‘start over’ with the first color, 
once the last color is reached.  Colors go in order from left to right.  If you don’t want to use a 
color, simply uncheck the box below that color.  You can even use the color Black to “blackout” in 
between other colors. 

• The up / down slider on the right acts as an interval between each color.  Using the example, the 
first color shown will be Red.  The fixtures will stay Red for approximately 0.6 seconds because the 
slider is set to around 60.  The slider ranges in value from about 0.1 seconds to 1.0 seconds, with 
100 = 1 second.  Values below 20 make the colors change extremely fast, almost like a strobe ef-
fect.  If the Interval check box is not checked, then no interval is used, and the fixtures are updated 
extremely fast!  This can actually cause the fixtures to become “confused”, therefore the Interval 
check box should almost always remain checked. 

• The Gradient check box is very cool!  By using the gradient, each color will “color shift” into the 
next color.  Try it and see what happens! 

• Click the Activate button to activate the fixtures.  The settings that you have when you click the 
Activate button are the ones sent to the fixtures.  So any changes to the colors etc, only take place 
the next time you click on Activate.  Once activated, the button changes to saying “Blackout”.  
Simply click the button again to Blackout the fixtures. 

 

Control Boxes 1 through 5 and the 
Quick Set Box are designed to be 

used with RGB type fixtures.  
However, they can also be used 
with ‘Standard’ flood-lamp type 

PAR cans. 
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Storing all of your settings 
If you had to reset all of your settings (check boxes, colors, etc) every time you ran Prosurv DMX, you’d 
probably get quite frustrated!  So Prosurv DMX gives you an easy way of storing all of your settings instantly! 
 
Simply use the Save or Save As feature of the program, located under the File menu, to save your settings.  
When saving, you can enter a file name that the settings will be stored under.  For example, you could save the 
settings for your Main Street Theatre as Main Street Theatre (how intelligent)!  Then the next time you have to 
run the lights there, simply open that “job file”. 
 
Always be sure to save your job every time you make a change.  You will NOT be prompted to save your 
changes when closing the program!  You should get used to pressing Ctrl-S (which saves the job) every time 
you’ve made one or more changes. 
 
When you run Prosurv DMX, you will be prompted whether you want to open your last “job” file.  Just click 
Yes, and the job is opened. 
 
Well, that should give you the start that you need to become an expert at using Prosurv DMX!  In reality, Pro-
surv DMX has been designed to be very easy to use.  Once you become familiar with the controls, you should 
be able to simply figure out how to use everything in the program!  But, if not, please don’t hesitate to contact 
us, as we look forward to hearing from you! 
 
Adding to the Prosurv DMX Library 
Yes, you can add virtually any fixture to the Prosurv DMX Library, as long as you know the DMX channels 
and values for that fixture (i.e. a DMX chart). 
 
Prosurv DMX has a built-in Library addition capability.  This lets you, the user, add fixtures to the library on 
your own!  Please visit our web site at www.prosurv.com/dmx for more details, and to download the “Prosurv 
DMX Library instruction manual PDF”. 
 
 


